
ApexSQL Data Diff  

Version 2019.x 

Release Notes and Requirements 

 

System requirements 

Hardware Dual Core 2.0 GHz CPU 

3 GB memory 

205 MB disk space 

SQL Server SQL Server 2005 and higher [1] 

Azure SQL Database [1] 

Amazon RDS for SQL Server [1] 

Add-in integration Visual Studio 2010 and higher [1] 

Server Management Studio 2012 and higher [2] 

OS Windows 7 SP1/Windows Server 2008 R2 SP1 and higher [1] 

Software .NET Framework 4.7.2 or higher 

Note Source control integration available for Azure DevOps [4], Git [5], 

Mercurial [5], Subversion [5] and Perforce [5] 

Permissions and 

additional 

requirements 

Windows user account with administrative privileges 

See Minimum permissions required to install and use ApexSQL 

products 

See Minimum SQL Server permissions for ApexSQL Developer tools 

See Remote access for SQL Server instance 

[1] See Supported systems for exact version support 

[2] You can use the latest full-featured backwards compatible SQL Server Management Studio for 

free. Click here 

[4] Azure DevOps Server (TFS) [5] / Azure DevOps Services 

[5] Up to the latest version 

https://support.microsoft.com/en-us/help/4054530/microsoft-net-framework-4-7-2-offline-installer-for-windows
https://support.microsoft.com/en-us/help/4054530/microsoft-net-framework-4-7-2-offline-installer-for-windows
https://blog.apexsql.com/source-control-support-for-apexsql-products/
https://blog.apexsql.com/source-control-support-for-apexsql-products/
https://knowledgebase.apexsql.com/minimum-permissions-required-to-install-apexsql-products/
https://knowledgebase.apexsql.com/minimum-permissions-required-to-install-apexsql-products/
https://knowledgebase.apexsql.com/minimum-permissions-required-to-install-apexsql-products/
https://knowledgebase.apexsql.com/minimum-permissions-required-to-install-apexsql-products/
https://knowledgebase.apexsql.com/minimal-sql-server-permissions-apexsql-developer-tools/
https://knowledgebase.apexsql.com/minimal-sql-server-permissions-apexsql-developer-tools/
https://knowledgebase.apexsql.com/configure-remote-access-connect-remote-sql-server-instance-apexsql-tools/
https://knowledgebase.apexsql.com/configure-remote-access-connect-remote-sql-server-instance-apexsql-tools/
https://www.apexsql.com/supported-software.aspx
https://www.apexsql.com/supported-software.aspx
https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms
https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms


 

Supported Software 

Windows version 

Windows 7 SP1 & 

Windows Server 

2008 R2 SP1 

Windows Server 

2012 

Windows 8.1 & 

Windows Server 

2012 R2 

Windows 10 & 

Windows Server 

2016 

Windows Server 

2019 

     

 

SQL Server version [3] 

 2005 2008 2012 2014 2016 

2017 2019 CTP 3 

Windows Linux [2] Windows Linux [2] 

ApexSQL 
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SQL Server edition [3] 

 Express Standard Enterprise 

Azure SQL Database 

Amazon RDS 

for SQL Server 
Single 

Database,  

Elastic Pool 

Managed 

Instance 
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Visual Studio add-in integration 

https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx


 2010 2012 2013 2015 2017 2019  
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SQL Server Management Studio add-in integration 

 2012 2014 2016 17 18  
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Source control systems 

 Azure DevOps [4] Git [5] Mercurial [5] Perforce [5] Subversion [5] 
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[2] Tested on Ubuntu 16.04 

[3] Including Amazon EC2, Google Compute Engine, and Azure Virtual Machine cloud computing SQL 

Server instances 

[4] Azure DevOps Server (TFS) [5] / Azure DevOps Services 

[5] Up to the latest version 

 

Getting Started 

For further information about installation and getting started, please check the Quest Knowledge Base 

or ApexSQL Getting Started. 

 

Release Notes (release history) 

Release: 2019.01.0522 

https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://support.quest.com/apexsql-data-diff/kb
https://support.quest.com/apexsql-data-diff/kb
https://www.apexsql.com/getting_started.aspx
https://www.apexsql.com/getting_started.aspx
https://www.apexsql.com/sql_tools_readme.aspx?Product=DataDiff
https://www.apexsql.com/sql_tools_readme.aspx?Product=DataDiff


Date:  January 09, 2020 

Enhancements: 

• SQL Server 2019 support 

• Temporal tables support 

• SQL graph tables support 

• Pre-comparison quick-check for data differences option is added under the Object filter tab 

of the New project window 

• Play a sound upon finished operation option is added under the General tab of the Options 

window 

Fixes: 

• "Reloading metadata failed. Invalid URI: The URI is empty" message is shown when running a 

project file which contains the Active Directory - Universal with MFA support authentication 

• The Data compare query window is not shown when a SQL database is right-clicked and the 

Set as source or destination command is used in Visual Studio 

• Authentication type is automatically changed to the Active Directory - Universal with MFA 

support authentication when changing SQL Server 

• "Reloading metadata failed” error is encountered when trying to compare two Git 

repositories from Bitbucket.org 

• "Specified cast is not valid" error is encountered when the filter option for the column is 

clicked in the Data Difference view panel 

• The Save button is not working properly when editing project settings 

• "Execution Timeout Expired. The timeout period elapsed prior to completion of the operation 

or the server is not responding" error is encountered while retrieving row count for the Row 

filter dialog 

• Backspace key selects text under the condition box of the Filter editor dialog instead of 

deleting it 

• "Item has already been added" error is encountered when all objects are unmapped under 

the Object mapping tab in the New project window 

• The Synchronization summary in the CLI shows that different records are updated, even 

though the “d” (different) argument is not used in the /records_to_synchronize switch 

• The application add-in is integrated in all SQL Server Management Studio and Visual Studio 

versions through the silent installation even though the /components switch with its values is 

not specified 

• The application cannot be uninstalled if any version of Visual Studio is running, even though 

the application is not integrated into any VS 

• "Value cannot be null" error is encountered when using the Copy cell value right-click 

command in the Data difference view panel for the Null cell value 

• The application's add-in is integrated automatically in SQL Server Management Studio when 

installed via ApexSQL Installer 

• "Check for update failed. Problem occurred connecting to the ApexSQL server" error is 

encountered when the Get updates button is used from the ApexSQL menu in Visual Studio 

2019 

https://blog.apexsql.com/sql-server-2019-ga-support-for-apexsql-products/
https://blog.apexsql.com/sql-server-2019-ga-support-for-apexsql-products/


Changes: 

• Dark theme is now used as the default application theme 

• Save as dialogs are now inheriting the application theme 

 

Release: 2018.07.0386 

Date:  June 21, 2019 

Changes: 

• Software Transaction Agreement is added as a new step in the installation wizard and 

updated in accordance with https://www.quest.com/legal/sta.aspx 

Release: 2018.07.0384 

Date:  June 13, 2019 

Fixes: 

• The application doesn't integrate with SQL Server Management Studio 18 GA version 

• "Object reference not set to an instance of an object" error is encountered when the OK 

button is clicked in the Connection options dialog after changing value for timeout options 

• The application is started in light theme, when the Data comparison is initiated from SQL 

Server Management Studio 

• Check-boxes cannot be checked under the Object filter tab, if the New project window is 

resized 

• The sort order is not numerical in the Data difference view panel, instead the INT columns are 

arranged by order of only the first digit 

Known limitations: 

• Data sources containing SQL tables without a unique clustered index cannot be compared 

against database backups 

• The Get by label option is not retrieving label state and it uses the latest instead when using 

Mercurial repository 

 

Release: 2018.06.0324 

Date:  February 05, 2019 

Enhancements: 

• SQL Server 2019 CTP 2.0 support 

https://www.quest.com/legal/sta.aspx
https://www.quest.com/legal/sta.aspx


• SQL Server Management Studio 18 integration support 

• Visual Studio 2019 integration support 

• Active Directory authentication – Universal with MFA support 

• CLI switches: 

o Tables with specified schemas can be filtered via the /include switch: 

"Schemaname.ObjectName" 

o New value for the Synchronization options switch: Ignore pre-processing script failure 

[ippsf] 

o New value for the compatibility level /cl1 and /cl2 switches: SQL2019 [2019] 

Fixes: 

• "Could not load file or assembly 'Microsoft.SqlServer.Smo" error is encountered when the 

Browse button is clicked for the Use this directory option of the Backup the database before 

synchronization option in the Synchronization wizard 

• The number of rows is not shown in the Rows column of the Object filter when Script folder 

or Source control are used as data sources 

• The Get by label option is not retrieving label state and it uses the latest instead when using 

Team Foundation Server repository 

• Server field is empty on the Destination side under the Data sources tab when the New 

button is clicked in the Project management window 

• Incorrect comparison results are shown when rows are shown as missing and additional, 

instead of different, after the initial comparison key is changed 

• Missing ability to include tables with specified schemas through the CLI using the /include 

switch 

• Redundant double quotation marks around the application installation path for the 

generated PowerShell script under the Automation script window 

• Redundant double quotation marks and output name are shown in the Automation script 

window 

• "The specified folder does not contain the appropriate folder structure" message is shown 

when a selected source control project contains the Assemblies folder 

• The set date format yyyyMMdd for the Apply date format option is not applied in the 

synchronization script 

• Filters are not working when any value is entered for specified column in the Results grid 

• Filters are not working when any value is entered for specified column in the Data difference 

view window 

• Objects cannot be unchecked under the Object filter tab of the New project window when 

the object list is filtered by name or schema 

• The custom object mapping pairs are not checked by default under the Object filter tab for 

the comparison process 

• Memory optimized tables are not synchronized and an error is encountered when the 

Include transaction handling in synchronization script option is checked under the Options 

tab of the New project window 

Changes: 

https://blog.apexsql.com/sql-server-management-studio-ssms-18-support-for-apexsql-tools-add-ins/
https://blog.apexsql.com/sql-server-management-studio-ssms-18-support-for-apexsql-tools-add-ins/
https://blog.apexsql.com/visual-studio-2019-preview-support-for-apexsql-tools-add-ins/
https://blog.apexsql.com/visual-studio-2019-preview-support-for-apexsql-tools-add-ins/


• Backup database before synchronization is now unchecked by default 

• Default value for the /backup switch is set to None 

• The application now requires Microsoft .NET framework 4.7.2 

• ApexSQL parent menu of the add-in is now located under the Extensions main menu in 

Visual Studio 2019 

Known limitations: 

• Data sources containing SQL tables without a unique clustered index cannot be compared 

against database backups 

• The Get by label option is not retrieving label state and it uses the latest instead when using 

Mercurial repository 

 

Release: 2018.05.0244 

Date:  September 06, 2018 

Enhancements: 

• New error handling and send logs functionality 

• Improved application installer with a dark theme 

• New application icon 

• High DPI and 4K resolution support 

• Save automation script as a PowerShell script 

• Visual Studio integration support 

• Active Directory – Password authentication support 

• Active Directory – Integrated authentication support 

• Comparison summary output is added under the Export options in the Home tab 

• Ignore pre-processing script failure option is added under the Synchronization options 

• Additional outputs are added in the Automation script window for: 

o Comparison summary 

o Synchronization actions 

o Synchronization warnings 

o Execution results 

o Synchronization summary 

• CLI switches: 

o Source and destination login for Azure Active Directory authentication [/ad1 and 

/ad2] 

o Folder mapping settings for source and destination data sources [/fm1 and /fm2] 

o New value for the Synchronization options switch: Ignore pre-processing script failure 

[ippsf] 

o Name of the executable installer or C# solution package [/pknm] 

Fixes: 

https://knowledgebase.apexsql.com/how-to-send-log-files-from-apexsql-tools/
https://knowledgebase.apexsql.com/how-to-send-log-files-from-apexsql-tools/
https://blog.apexsql.com/the-new-apexsql-installer/
https://blog.apexsql.com/the-new-apexsql-installer/
https://blog.apexsql.com/apexsql-tool-icons-screenshot-tour/
https://blog.apexsql.com/apexsql-tool-icons-screenshot-tour/
https://blog.apexsql.com/4k-resolution-and-high-dpi-scaling-support-in-apexsql-tools-add-ins/
https://blog.apexsql.com/4k-resolution-and-high-dpi-scaling-support-in-apexsql-tools-add-ins/
https://knowledgebase.apexsql.com/save-project-as-automation-script/
https://knowledgebase.apexsql.com/save-project-as-automation-script/


• “Column 'ColumnName' does not belong to table” error is encountered when the custom 

mapped tables and columns are selected in the Results grid to view data differences 

• “Object reference not set to an instance of an object” error is encountered when SQL Server 

2005 database is compared with a SQL Server 2014 database 

• Data source information are not remembered when the Edit button is clicked for the 

currently compared data sources 

• Tables and columns with different names are not shown in the Object filter tab, even though 

they were mapped in the Object mapping tab 

• Project file is shown in the Recent projects list even after the Delete or Remove from list 

commands were used 

• Project file is not shown in the Recycle bin when the Delete right-click command is used in 

the Project management window 

• The /records_to_synchronize switch does not contain any value if all objects are unchecked 

and the Save as batch feature is initiated 

• Missing the "n" value in the /output_elements switch under the Save as batch window, when 

none of the Output elements options is checked 

• The /on switch is not shown in the Batch script for the C# solution and Executable installer, 

even though the Package name from the Package tab is checked 

• The shortcut (Ctrl + E) for the Edit current project settings command does not work 

• The shortcut (F5) for the Refresh command does not work 

• Missing the Last value for the /backup_set1 and /backup_set2 switch value to choose the last 

backup set 

• "The type initializer for 'ApexSql.Common.UI.Forms.MetroMessage' threw an exception" error 

is encountered when activating the application through add-in in SQL Server Management 

Studio 

• Wrong values are specified in the /records_to_synchronize switch when only 

different/missing/additional rows checked 

• "The custom key must contain at least one checked field" message is shown when the Save 

button is clicked after a click on the Reset button in the Customize comparison key 

• The data comparison process cannot be initiated from SQL Server Management Studio when 

SQL Server authentication is used in the Data compare query 

• SQL Server Management Studio stops working when SQL Server instance is not chosen and 

Database list is used from Database drop-down list in Data compare query window 

• SQL Server Management Studio stops working when the Setup button is clicked in the Data 

compare query window to initiate the Source control setup wizard 

• SQL Server Management Studio stops working when SQL Server instance is not chosen and 

Database list is used from Database drop-down list in Data compare query window 

• SQL Server Management Studio stops working when use the Data compare option on a SQL 

Server Analysis Services instance 

• "There is not enough space on the disk" error is encountered while comparing data sources 

and there is no more space on disk 

• "Source control error: Delete failed for 'Item 'ItemName' is obsoleted" error is encountered 

when trying to delete folder in the Subversion source control repository 

• “Reloading metadata failed” error is encountered when comparing data source against a 

Team Foundation Server repository label 



• Release and patch update application error issue when the updating gets canceled on 0% of 

download, and then started again 

• Wrong values are specified in the /records_to_synchronize switch when only 

different/missing/additional rows checked 

• “Cannot connect to '(local)'” error is encountered when there is no default named instance 

(local) on a machine where the application is installed 

• Errors are not shown in the top of the Results window if any is encountered during the 

synchronization process 

• The Results window does not contain information about how much rows is 

updated/deleted/added to a synchronized object(s) when synchronizing to a database 

• The missing rows are wrongly shown in the Additional column in the Comparison summary 

when using the CLI 

• Missing the information about executing Pre and Post processing scripts in the Actions tab 

• "Package executed successfully" message is shown in the Execution results window of an 

executable installer even when the execution is canceled upon first error 

• Missing an information message when mapping newly added objects to the save project in 

the CLI 

• The copy row values command from the right-click context menu of the Data difference view 

panel pastes inverted row order 

Changes: 

• Save as batch is now Automation script 

Known limitations: 

• Data sources containing SQL tables without a unique clustered index cannot be compared 

against database backups 

• The Get by label option is not retrieving label state and it uses the latest instead when using 

Mercurial repository 

 

Release: 2018.04.0216 

Date:  July 31, 2018 

Fixes: 

• "Could not load file or assembly 'file:///Windows-

Drive:\WINDOWS\Microsoft.Net\assembly\GAC_MSIL\ApexSQL.Engine.Controller'" error is 

encountered when a backup is loaded as a data source in the Data sources tab of the New 

project window 

• "Unknown error has occurred. Please see %AppData%\Local\ApexSQL\ApexSQL 

AppName>\crash.txt" error is encountered when ApexSQL Log or ApexSQL Recover are 

started while ApexSQL Data Diff is installed 



Known limitations: 

• Data sources containing SQL tables without a unique clustered index cannot be compared 

against database backups 

• The Get by label option is not retrieving label state and it uses the latest instead when using 

Mercurial repository 

• Labels cannot be compared for the Team Foundation Server repository 

 

Release: 2018.03.0215 

Date:  June 15, 2018 

Fixes: 

• SQL Server Management Studio stops working when ApexSQL Data Diff 2018 R2 add-in is 

installed alongside ApexSQL Diff 2018 add-in and any Schema compare command is initiated 

Known limitations: 

• Data sources containing SQL tables without a unique clustered index cannot be compared 

against database backups 

• The Get by label option is not retrieving label state and it uses the latest instead when using 

Mercurial repository 

• Labels cannot be compared for the Team Foundation Server repository 

 

Release: 2018.02.0205 

Date:  January 26, 2018 

Fixes: 

• The add-in icons disappear in SQL Server Management Studio 2012 and 2014 when installed 

in parallel with any other ApexSQL add-in product released after January 22, 2018 

• The application repeatedly asks for the activation key when it is started on an Amazon EC2 

instance after the virtual machine resources were deallocated and allocated again 

• The silent installer is stopped when the application needs to automatically download and 

install .NET Framework, even when the /verysilent switch is used 

Known limitations: 

• Data sources containing SQL tables without a unique clustered index cannot be compared 

against database backups 

• The Get by label option is not retrieving label state and it uses the latest instead when using 

Mercurial repository 



• Labels cannot be compared for the Team Foundation Server repository 

 

Release: 2018.01.0193 

Date:  December 27, 2017 

Enhancements: 

• High DPI and 4K resolution support 

• Applied concepts of Visual Language Dictionary for Visual Studio for iconography, imagery, 

colors, menus, fonts, formatting and other GUI elements 

• Check/Uncheck all missing/different/additional rows context menu and Home tab options 

are added for SQL tables and views in the Results section 

• Copy row values option is added to the right-click menu in the Data difference panel 

Fixes: 

• "HTML option is already selected as secondary output type. Select another primary output 

type" message is shown even when the Secondary output type is unchecked in the Save as 

batch window 

• The cursor is always back to the beginning of the text box for the Package name option when 

the tag buttons are clicked 

• The warnings output file cannot be created without its dependent switch /synchronize 

• The progress bar for the comparison process is not showing the exact percentage while 

comparing 

• The /indicate_default_db switch does not contain quotation marks in the Save as batch 

window 

• Total number of rows is shown in the Comparison process window even when the Row filter 

is used to narrow down the amount of rows 

• The View tab in the Object filter and Object mapping tabs is not shown even though the 

View option is selected in the Options tab of the New project window under the Objects to 

compare section 

• The Project management window is opened in front of the Update window when new update 

is available 

• The number of mapped columns is not changed until the selection is changed to another 

object 

• The number of the columns is not changed in the Object filter for the edited object, but the 

number of columns is changing for other objects, when the Filter editor is applied 

• "Attempt by method" error is encountered when the Refresh button is clicked for branches 

when the Mercurial source control system is chosen 

• SQL Server Management Studio 2016 and 17 stops working when a database backup is 

loaded in the Data compare query window 

• The title and source and destination data sources are not shown in exported reports if none 

of the Header options is checked under the Options tab in the New project window 

https://blog.apexsql.com/4k-resolution-and-high-dpi-scaling-support-in-apexsql-tools-add-ins/
https://blog.apexsql.com/4k-resolution-and-high-dpi-scaling-support-in-apexsql-tools-add-ins/
https://blog.apexsql.com/visual-language-dictionary-for-visual-studio-for-iconography-colors-and-other-visual-concepts-applied-in-apexsql-tools-add-ins/
https://blog.apexsql.com/visual-language-dictionary-for-visual-studio-for-iconography-colors-and-other-visual-concepts-applied-in-apexsql-tools-add-ins/
https://blog.apexsql.com/visual-language-dictionary-for-visual-studio-for-iconography-colors-and-other-visual-concepts-applied-in-apexsql-tools-add-ins/
https://blog.apexsql.com/visual-language-dictionary-for-visual-studio-for-iconography-colors-and-other-visual-concepts-applied-in-apexsql-tools-add-ins/


• Nothing is shown at the top of the exported report when one or two header options are 

checked under the Options tab in the New project window 

• Tables with text columns are missing in the Results panel and their number is shown as 

excluded in the status bar, even though they are mapped and checked for the comparison, 

when the Ignore case in the text data types option is checked 

• The license file disappears when virtual machine is stopped and then run on Amazon AWS 

• "The selected source control project does not have a corresponding folder structure for 

tables/views" message is shown when the Test or Finish button is clicked for the Perforce 

source control depot 

• "Make sure that correct username and password are specified" message is shown when 

specifying local folder as repository for the Git source control system, which doesn't require 

username and password 

• "The selected source control project does not have a corresponding folder structure for 

tables/views" message is shown when the Browse button is clicked to select a project for a 

Git repository hosted by Visual Studio Online 

Known limitations: 

• Data sources containing SQL tables without a unique clustered index cannot be compared 

against database backups 

• The Get by label option is not retrieving label state and it uses the latest instead when using 

Mercurial repository 

• Labels cannot be compared for the Team Foundation Server repository 

 


